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Efeitos – Vista Geral  
 
Ao trabalharmos no Samplitude, podemos manipular o 
material de áudio em cinco níveis. O sinal flui através destes 
níveis na seguinte seqüência:  
 

1. Efeitos destrutivos (Effects Menu). Os efeitos serão 
aplicados (renderizados) diretamente no material de 
áudio (internamente após uma cópia do material para 
propósitos de undo). Aplicamos efeitos acessando o 
diálogo através do menu Effects.  

2. Efeitos e manipulações em nível de objeto em virtual 
projects (Processamento em real time) são realizados no 
Object Editor.  

3. Nas automações de volume e pan, inclui-se faders de 
volume no Mixer ou na VIP (Tempo real).  

4. Efeitos em tempo real nas trilhas do Mixer (tempo real).  
5. Efeitos em tempo real na seção Mix Master (tempo real).  

 
 
Nem todos os efeitos estão disponíveis em todos os estágios 
de processamento. Existem algumas limitações:  
 

• Denoiser, Convolution, DC removal and Declipping estão 
disponíveis somente como efeitos destrutivos.  

• Room-Simulator somente em modo destrutivo. 
• Timestretching/Pitchshifting/Resampling somente está 

disponível como efeito destrutivo e como efeito de 
objeto.  

 
 
Salvando os parâmetros de efeitos (Preset Mechanism)  
Os diálogos de efeitos opções de Preset. Estes pré-ajustes são 
salvos e recarregados para/da pasta ‘fx-preset’ (uma 
subpasta da pasta principal onde o Samplitude está 
instalado).  
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Caso um preset não esteja localizado nesta pasta, ainda 
assim ele poderá ser carregado através da função ‘Load 
Setup’, mas ele não aparecerá automaticamente na caixa de 
seleção, de forma que será necessário um browser para este 
processo.  
 
Os efeitos que são adicionados/carregados dentro do Mixerou 
do Object Editor são pré-configurados com os valores 
atribuídos ao virtual project. Caso o virtual project for adotar 
as alterações feitas nos ajustes do efeito, necessitaremos 
clicar no botão OK para transferí-los para o VIP.  
 
 
Efeitos em tempo real  
Os efeitos em tempo real serão processados em tempo real 
durante a reprodução do áudio que vem do disco rígido. Os 
efeitos serão aplicados de modo não-destrutivo, em tempo 
real, ao stream de áudio. Os arquivos de áudio originais não 
serão alterados fisicamente. Podemos alterar os ajustes dos 
parâmetros em tempo real. Os efeitos são aplicados em um 
novo arquivo de áudio que será criado pelo processo track 
bouncing da VIP (ou parte dele). Efeitos em tempo real 
podem ser aplicados em três diferentes níveis: Object Editor, 
Track Effects e na seção Mix Master section. Esta também é a 
ordem da aplicação.  
 
Object Effects  
Todos os efeitos de trilha podem ser usados em qualquer 
Objeto. Para fazer isso devemos abrir a janela Object Effects 
e selecionar os efeitos. Há determinadas vantagens no 
emprego da Object Effects em comparação com os efeitos de 
trilha.  
 

1. Efeitos que exigem muito da CPU podem ser 
usados de um modo mais efetivo.  Exemplo: Além de 
seu reverb principal você poderá adicionar efeitos 
inteiramente diferentes em uma caixa de bateria para 
acentuar um pouco mais seu timbre. Para fazer isso será 
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necessário separar a batida da caixa da trilha de bateria 
e mover as batidas da bateria para uma trilha em 
separado. Utilizado como efeito de trilha o segundo 
reverb será sempre incluindo junto mesmo que seja por 
um curto momento. No entanto, podemos deixar as 
batidas isoladas da caixa na primeira trilha e adicionar o 
reverb como um Object preferivelmente.  

 
2. Não precisamos possuir muitas trilhas. Em vez de 

possuir uma trilha em separado para cada efeito ou EQ 
diferente que se ajuste a um determinado instrumento 
de acordo com as partes diferentes de um arranjo, 
podemos aplicar Object effects e possuir apenas uma 
trilha gravada.  

3. Todas as configurações são mantidas quando 
movemos ou copiamos o Objeto.  

4. Todos os efeitos configurados no Object (todas as 
configurações de efeitos individuais incluindo 
todas as configurações de plugins de efeitos Direct 
X / VST) podem ser copiados e colados em um 
outro Objeto.  

 
Exemplo: Para criar o famoso efeito "dub" em uma trilha de 
caixa de bateria (uma quantidade enorme de reverb em uma 
única batida da caixa), dê um corte bem justo na respectiva 
batida de caixa. Então carregue o room simulator (ou um 
plugin apropriado) no Objeto caixa e o ajuste as suas 
necessidades. Carregue o preset de roteamento "Room Sim 
Post Fades" FX quando o fade-out do "Snare Object" começar 
de forma a se certificar que o reverb permanecerá na 
mixagem por trás do final do Objeto. Pressione então o botão 
deste diálogo ou no Object Editor. Depois disso você poderá 
colar este "reverb hit" em todas as batidas de caixa que 
desejar processar. Podemos variar ligeiramente as 
configurações do reverb em cada Objeto.  
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Significado do Processamento do Efeito e ordem de 
manipulação do sinal  
A seqüência do processamento do efeito e de outras 
manipulações, tais como automação de volume e pan, afeta 
frequentemente o resultado. Alguns efeitos dependem do 
nível do sinal de entrada.  
 
Todas as funções Dinâmicas e as que removem ou reduzem 
ruídos, tais como De-hisser e Noise Reduction, são 
dependentes do nível do sinal de entrada e , e alguns casos, 
da resposta de freqüência do sinal de entrada. Caso encontre 
um bom ajuste para os parâmetros, você não deverá efetuar 
mudanças em outros blocos do efeito que precedam estes 
tipos de efeitos. Por exemplo, use o De-hisser e a seção Multi-
band Dynamics no Mix Master somente depois que todas as 
alterações restantes forem aplicadas nos objetos individuais e 
nos canais do Mixer.  
 
Em conseqüência disso é importante compreender o fluxo do 
sinal no Samplitude. Este fluxo pode ser alterado no diálogo 
FX routing.  
 

Preview Guia de Operação Samplitude - MUSICAUDIO

www.musicaudio.net
82 30328323

www.m
us

ica
ud

io.
ne

t  w
ww.m

us
ica

ud
io.

ne
t  w

ww.m
us

ica
ud

io.
ne

t 

www.m
us

ica
ud

io.
ne

t  w
ww.m

us
ica

ud
io.

ne
t  w

ww.m
us

ica
ud

io.
ne

t 

www.m
us

ica
ud

io.
ne

t  w
ww.m

us
ica

ud
io.

ne
t  w

ww.m
us

ica
ud

io.
ne

t 

www.m
us

ica
ud

io.
ne

t  w
ww.m

us
ica

ud
io.

ne
t  w

ww.m
us

ica
ud

io.
ne

t 

www.m
us

ica
ud

io.
ne

t  w
ww.m

us
ica

ud
io.

ne
t  w

ww.m
us

ica
ud

io.
ne

t 

www.m
us

ica
ud

io.
ne

t  w
ww.m

us
ica

ud
io.

ne
t  w

ww.m
us

ica
ud

io.
ne

t 

www.m
us

ica
ud

io.
ne

t  w
ww.m

us
ica

ud
io.

ne
t  w

ww.m
us

ica
ud

io.
ne

t 

www.m
us

ica
ud

io.
ne

t  w
ww.m

us
ica

ud
io.

ne
t  w

ww.m
us

ica
ud

io.
ne

t 

www.m
us

ica
ud

io.
ne

t  w
ww.m

us
ica

ud
io.

ne
t  w

ww.m
us

ica
ud

io.
ne

t 

www.m
us

ica
ud

io.
ne

t  w
ww.m

us
ica

ud
io.

ne
t  w

ww.m
us

ica
ud

io.
ne

t 

www.m
us

ica
ud

io.
ne

t  w
ww.m

us
ica

ud
io.

ne
t  w

ww.m
us

ica
ud

io.
ne

t 

www.m
us

ica
ud

io.
ne

t  w
ww.m

us
ica

ud
io.

ne
t  w

ww.m
us

ica
ud

io.
ne

t 

www.m
us

ica
ud

io.
ne

t  w
ww.m

us
ica

ud
io.

ne
t  w

ww.m
us

ica
ud

io.
ne

t 

www.m
us

ica
ud

io.
ne

t  w
ww.m

us
ica

ud
io.

ne
t  w

ww.m
us

ica
ud

io.
ne

t 

www.m
us

ica
ud

io.
ne

t  w
ww.m

us
ica

ud
io.

ne
t  w

ww.m
us

ica
ud

io.
ne

t 

www.m
us

ica
ud

io.
ne

t  w
ww.m

us
ica

ud
io.

ne
t  w

ww.m
us

ica
ud

io.
ne

t 

www.m
us

ica
ud

io.
ne

t  w
ww.m

us
ica

ud
io.

ne
t  w

ww.m
us

ica
ud

io.
ne

t 

www.m
us

ica
ud

io.
ne

t  w
ww.m

us
ica

ud
io.

ne
t  w

ww.m
us

ica
ud

io.
ne

t 

www.m
us

ica
ud

io.
ne

t  w
ww.m

us
ica

ud
io.

ne
t  w

ww.m
us

ica
ud

io.
ne

t 

www.m
us

ica
ud

io.
ne

t  w
ww.m

us
ica

ud
io.

ne
t  w

ww.m
us

ica
ud

io.
ne

t 

www.m
us

ica
ud

io.
ne

t  w
ww.m

us
ica

ud
io.

ne
t  w

ww.m
us

ica
ud

io.
ne

t 

www.m
us

ica
ud

io.
ne

t  w
ww.m

us
ica

ud
io.

ne
t  w

ww.m
us

ica
ud

io.
ne

t 

www.m
us

ica
ud

io.
ne

t  w
ww.m

us
ica

ud
io.

ne
t  w

ww.m
us

ica
ud

io.
ne

t 

www.m
us

ica
ud

io.
ne

t  w
ww.m

us
ica

ud
io.

ne
t  w

ww.m
us

ica
ud

io.
ne

t 

www.m
us

ica
ud

io.
ne

t  w
ww.m

us
ica

ud
io.

ne
t  w

ww.m
us

ica
ud

io.
ne

t 



Efeitos Offline  
As opções disponíveis no Menu Offline Effects são processadas 
diretamente nos projetos Hard Disk Projects (HD Wave), RAM 
Projects (RAP), ou Objetos que estejam selecionados em uma 
janela VIP. Com exceção da opção Normalize Object (Virtual), 
os efeitos são processados no modo destrutivo. Em outras 
palavras, os arquivos de áudio original serão substituídos com 
o arquivo processado. Caso a opção Create Copy esteja 
selecionada (existente em cada janela de Effect), o áudio 
processado será adicionado no final do arquivo original que 
não foi processado com os efeitos (dry).  
 
Quando processar objetos selecionados na janela VIP, e 
possuindo esta cópia, será permitido o processo de Undo 
(desfazer uma operação) para restaurar o Objeto ao seu 
estado não processado (dry). O áudio adicionado é retido no 
projeto (mesmo que não sofra mais referências na VIP) a 
menos que seja retirado deliberadamente, manualmente ou 
com o emprego da função Tools > Remove Unused Samples.  
 
Nota: Se você processar um objeto selecionado que apareça 
em uma outra parte no Projeto (por exemplo, um loop-based 
Project) e você não tenha selecionado a opção Create Copy, 
todas as cópias deste Objeto no Projeto serão afetadas, 
assim como o arquivo original que foi processado de forma 
destrutiva. Isto não ocorrerá caso a opção Create Copy seja 
marcada, porque agora o Objeto processado fará referência 
ao trecho de áudio que foi adicionado no final do arquivo 
original (leia o parágrafo anterior).  
 
Recomendamos que a opção Create Copy sempre esteja 
marcada quando você for aplicar Efeitos através do menu 
Effects. Mesmo que isso resulte em um Projeto maior que 
requeira mais espaço livre em disco, pois trabalhando dessa 
maneira você estará seguro de poder usar o recurso Undo 
(ou então o arquivo original) caso seja necessário.  
 
Caso a função Create Copy não esteja marcada, o recurso 
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Undo não estará disponível, não importando neste caso que o 
Undo esteja disponível em HD Wave Projects habilitado no 
diálogo Options > Program Preferences > Undo Definitions 
dialog. A única opção para desfazer uma aplicação de efeito 
mal feita será restaurar o backup do Projeto (acreditamos que 
não seja necessário lembrar que backups do projeto sejam 
feitos com regularidade). Esta regra aplica-se em projetos VIP 
e HD!  
 
Os diálogos de efeitos que oferecem a opção Create Copy 
(como diálogo Fade In/Out), criarão automaticamente um 
arquivo Undo, levando-se em consideração que o Undo é 
permitido para HD Wave projects (diálogo Options > Program 
Preferences > Undo Definitions). Estes arquivos Undo são 
temporários, e são deletados quando o Projeto é fechado.  
 
Dica: Caso a opção Create Copy seja usada (ao aplicar 
efeitos em um Objeto selecionado na janela VIP), você 
poderá usar o Take Manager para comutar entre cópias 
adicionadas (processadas), e o arquivo de áudio original 
(dry)!  

 
 
FX routing  
Para reordenar efeitos FX nativos e plugins de efeitos DirectX, 
clique no botão FX da trilha VIP ou na parte inferior do Mixer 
(abaixo das trilhas e do master). Isto abrirá o diálogo Effect 
Routing. (Reordenação de plugins DirectX/VST que são 
controlados via um botão Plug-in separado) as decisões de 
inserir/reordenar efeitos devem ser feitas com muito cuidado, 
especialmente quando usando Processamento Dinâmico, 
baseados em processadores FFT (Filter e De-hisser) e nas 
opções Pre/Post.  
 
Ao trabalhar mais tempo com este ambiente você estará mais 
por dentro das conseqüências que uma reordenação de 
efeitos pode causar no resultado final de um processamento. 
Com regra geral, é sempre importante diminuir o nível de 
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volume dos monitores. Dessa forma você evitará volumes 
excessivos que poderão até queimar os tweeters. Todas as 
alterações podem ser feitas no diálogo FX routing. A 
aparência do diálogo mudará ligeiramente dependendo de 
onde ele for aberto, Object Editor, Mixer Track ou Mixer 
Master, estando com um ou outro item desativado ou 
adicionado. A figura a seguir apresenta todos os elementos. 
  
A ordem de todos os efeitos é livremente configurável. 
"Effects", como um termo, refere-se não somente aos efeitos 
que possua um diálogo de configuração (por exemplo, 
Dynamics ou EQ), mas também ao fader de volume e de 
ganho, e também ao aux sends. Alguns itens estão 
acinzentados (inacessíveis), e somente se apresentam na lista 
para permitir o rearranjo da ordem dos efeitos.  

 
No diálogo Track FX, há duas entradas para o AUX send (pre 
e post), nos fornecendo uma flexibilidade máxima de 
roteamento. No diálogo AUX Settings, podemos comutar 
entre pre e post, com a entrada correspondente n fluxo de 
sinal que está sendo usada para “ramificar” o sinal AUX para 
seu AUX bus. Você perceberá que a operação de mandadas 
AUX é muito mais flexível que num console real, de forma que 
podemos colocar os dois aux sends em um determinado ponto 
no fluxo de sinal. Isto permite que coloquemos o AUX pre 
antes d fader de volume (como usual), no entanto, após do 
EQ (o que não é assim tão comum!).  
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Também podemos possuir duas entradas DirectX/VST, nos 
permitindo que coloquemos plug-ins em pontos pre e post. A 
ordem destes FX é definida por suas posições relativas no 
diálogo Plug-in chainer.  
 

 
 

Opções  
Use Advanced Dynamics for Mixer Dyn./Limiter: Na 
Master Track, "Advanced Dynamics" é acessado pelo botão 
"Dyn./Limiter", melhor que o limiter normal "Dynamics".  

 
All Tracks: O ajuste será aplicado em todas as trilhas 
(Track FX somente). 
  
FX Checkboxes: Cada efeito pode ser desligado 
individualmente, bastando para isso desmarcar a caixa de 
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seleção associada. Na página Object FX, temos a opção 
para remover um efeito introduzido com o botão 
"Remove". Isto conserva a memória RAM, porque o efeito 
é retirado da memória. Um efeito disponível, porém não 
carregado é indicado por uma linha horizontal na caixa de 
seleção associada. 

 
Edit: Este botão abre o diálogo de configurações do efeito 
atualmente selecionado (caso esteja disponível). 
  
Copy/Paste: Podemos rapidamente copiar um ajuste 
completo de FX (incluindo todos os efeitos nativos e 
plugins DirectX) para uma outra trilha/Objeto.  

 
FX list: Uma lista de todos os efeitos/elementos de 
colunas de canais é apresentada em ordem de 
processamento, de cima para baixo.  

 
Reset: Restaura todos os FX (off). 

 
On/Off: Comuta o efeito selecionado em "bypass". Efeitos 
ativos são indicados por uma marca de seleção.  
 
Remove: Remove os efeitos selecionados da memória, 
economizando recursos da RAM (Object editor somente). 
Os efeitos removidos são indicados por uma linha 
horizontal na caixa de seleção.  
 
Select input device (trilhas somente): As mesmas 
configurações que são encontradas no diálogo Track Info.  
 
Select output device or sub-mix bus (trilhas 
somente): As mesmas configurações encontradas no 
diálogo Track Info (Trilha) ou no diálogo Play 
Parameters (Master).  
 
Move: Desloca os itens da lista de acordo com os botões 
de seta para reordenar a ordem de processamento dos FX.  
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Copy/Paste: Podemos rapidamente transferir um 
roteamento de uma trilha para outra com os comandos 
copy/paste. Caso a trilha se caracterizar por um ajuste 
diferente de roteamento (ordem dos efeitos), ela será 
adaptada ao novo ajuste FX (devido ao fato da posição de 
roteamento ser armazenada como uma parte dos efeitos 
que são ajustados).  
 
Reset FX Order: Restaura o roteamento FX para a ordem 
padrão.  
 
Load/Save/Select Routing Preset: Podemos 
salvar/carregar nossos roteamentos personalizados. Há 
diversos pré-ajustes já fornecidos com o pacote, incluindo 
roteamentos de versões do Samplitude anteriores para 
efeito de compatibilidade.  
 
Diferenças entre os diálogos FX Routing no Object 
Editor, Track e Master  
No Object e Track FX routing existe um item especial 
chamado "FX Inserts". Os efeitos nativos mais complexos 
do Samplitude são agrupados e não podemos alterar aqui 
as posições dos itens neste grupo. Não obstante a isso, 
podemos alterar a posição do item "FX Inserts". 
 
No Object Editor somente existe um item (post) AUX send, 
e somente um (post) plug-in. Não há também nenhum 
roteamento de dispositivo In/Out.  
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Plug-Ins  
 

 
 
Esta função permite a utilização de plugins compatíveis com 
os padrões Microsoft DirectX e VST 2.0 no ambiente do 
Samplitude. Isto complementa os efeitos nativos já 
existentes.  
 
O Mixer e o Object Editor também são compatíveis com 
plug-ins, que podem ser usados em tempo real. Entretanto, 
os plugins têm que poder processar imediatamente e 
completamente os blocos de dados de áudio, sem alterar o 
comprimento do material. Este é o caso para a maioria dos 
outros algoritmos de plugins que falham, pois são baseados 
em alterações de comprimentos/durações de materiais.  
 
O menu Effects não possui estas limitações. Todos os plugins 
disponíveis, mesmo que se mude o comprimento de um 
determinado material de áudio.  
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Trabalhando com Plug-Ins  
Após a abertura do diálogo do plugin, uma lista do plugins 
instalados no computador será apresentada. Clique-duplo em 
um específico plugin para movê-lo do lado esquerdo do 
diálogo. O lado esquerdo apresenta os plugins ativos.  
 
Ao mesmo tempo que o plugin é movido para a área de 
plugins ativos o diálogo do plugin escolhido é aberto. Este 
diálogo permite que você efetue ajustes. Clique-duplos nos 
itens da lista da direita adicionam novos plugins na lista da 
esquerda. Certifique-se de que os plugins sejam compatíveis 
uns com os outros. Por exemplo, plugins mono e stereo não 
podem ser usados ao mesmo tempo – uma mensagem de 
erro será apresentada. Para este caso deverá ser “forçado 
um processamento em mono”.  
 
Pre/Post section (Mixer only)  
No Mixer, a lista de plugins é dividida em duas seções, pre e 
post. Na página FX routing da trilha ou da seção master 
existirá quatro itens correspondentes, DirectX plugin, Pre e 
Post e VST Plug-in pre e post. De forma que podemos usar 
um plugin, ou mais de um, em dois lugares diferentes na 
cadeia de efeitos. Todos os plugins carregados abaixo da linha 
pre na lista serão inseridos na cadeia de efeitos nas posições 
pre, todos os que estiverem abaixo da linha post estarão na 
posição post.  
 
Nota: Por razões técnicas não é possível posicionar plugin 
DirectX após plugins VST, se eles forem utilizados juntos em 
posições pre ou post. Para solucionar este problema, 
posicione o plugin VST na posição pre e o plugin DirectX na 
posição post.  
 
Elementos do Diálogo  
Play/Stop – Este botão ativa o preview em tempo real do 
plugin ativado. Esta função é ideal para testar os ajustes do 
plugin e dessa forma efetuar os melhores ajustes para o que 
for necessário. 
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Preview (somente menu Effects)– Esta função processa 
um pequeno segmento do material de áudio com o plug-in 
adicionado. Use esta opção caso o seu sistema não seja capaz 
de suportar prévias em tempo real (botão "Play/Stop’). A 
duração da prévia pode ser determinada com a configuração 
System (atalho: y) – Test buffers. 
 
Create Copy (only in Effects menu)– Esta função faz com 
que o Samplitude crie uma cópia do material original. Use 
esta opção se você achar que o seu computador não 
consegue processar o efeito em tempo real, obrigando então 
um processamento destrutivo. Esta função permite que a 
opção Undo retorne os dados originais ao objeto da VIP.  
 
Solo – Somente o plugin selecionado será usado.  
 
Mute – O plugin selecionado será mutado (função bypass). 
Podemos desligar temporariamente um plugin desmarcando a 
seleção na caixa que precede o seu nome.  
 
Remove – O plugin selecionado será retirado da cadeia de 
plugins.  
 
Plug-in latency: Apresenta um relatório de latência do 
Plugin. Com a opção Force Latency, podemos substituir este 
valor, no caso de uma informação errônea de latência para o 
Plugin.  
 
Setup:  
Write DirectX log file: Quando um plugin apresenta 
problemas em seu processamento, esta opção grava um 
arquivo de log para posterior consulta.  
 
Start all object related Plug-Ins at playback start: Esta 
opção somente é necessária quando usando plugin no Object 
Editor. Alguns plugins apresentam erros caso sejam iniciados 
de forma independente. Os erros ocorrem quando o objeto 
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com os plugins atribuídos é reproduzido. Podemos impedir 
isso selecionando esta opção. Por outro lado, a performance 
cairá bastante, porque o Samplitude terá que processar todos 
os plugins.  
 
Disable DirectX while Scrubbing/Jogging: Selecionada 
por padrão, porque alguns plugins muito populares 
apresentam problemas quando usamos a função scrubbing.  
 
Maximum VST /Direct X / VST BufferSize: Limite máximo 
do tamanho dos buffers VST /DirectX, o padrão é 128000 
samples.  
 
DirectX preload buffer size: Ajusta o tamanho inicial para 
o buffer de plugins DirectX plugins. Use -1 para UAD DirectX 
plugins. 
 
VST automation resolution (default 256) Ajusta a 
resolução de tempo VST. 
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Presets  
Saving and Loading – Estes dois botões localizados na parte 
superior da metade esquerda do diálogo permitem o 
salvamento e o carregamento de presets de plugins.  
 
Com os botões copy/paste  podemos transferir 
rapidamente configurações de uma instância  de plugin para 
outra.  
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